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Background
The transition from whole numbers to fractions and decimals can
be one of the most difficult challenges for mathematics students.
This is often due to students’ lack of understanding of some of the
most fundamental concepts of rational numbers. In light of this,
the National Council of Teachers of Mathematics (NCTM) devotes
much attention to fractions and decimals in the Curriculum and
Evaluation Standards for School Mathematics (Standards).
Standard 12 of the K-4 strand states,

The K-4 instruction should help students understand fractions
and decimals, explore their relationship, and build initial con-
cepts about order and equivalence. It is crucial that teachers use
physical materials, diagrams, and real-world situations in con-
junction with ongoing efforts to relate their learning experiences
to oral language and symbols. This K-4 emphasis on basic ideas
will reduce the amount of time currently spent in the upper
grades in correcting students’ misconceptions and procedural
difficulties. (Page 57)

The Grades 4-8 strand of the Standards adds that students should
be able to “understand, represent, and use numbers in a variety
of equivalent forms.” Seeing the same quantities as fractions,
decimals, and percents leads students to a stronger understand-
ing of the relationship between numbers. 

Moreover they should develop the ability to “read, use, and
appreciate multiple representations of the same quantity…”  (p.
87). Experiencing the same quantities in concrete, pictorial, and
abstract representations equips students with a wide range of
representations necessary to construct a thorough understanding
of the concept of “fraction.” For example, area models such as
“fraction bars,” hundreds blocks, and pie charts are good tools
for fostering students’ conceptualization of equivalence and rela-
tive size, while number lines provide a different perspective for
building an understanding of relative size. 
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Why Fraction Attraction?
Fraction Attraction answers the call set forth by the NCTM
Standards. While reinforcing the concept of multiple representa-
tions, it provides a stimulating environment where your students
can explore critical fraction concepts including:

 

❖ ordering 

❖ equivalence 

❖ relative size

❖ understanding fractions as representing distance on a
number line 

❖ addition and subtraction of fractions 

❖ “counting on” with fractions  

The program is designed to help your students acquire an under-
standing of these concepts through four different games: The
Frac Track, The Frac-o-Wheel, Fuzzy Fracs, and Whack-a-Frac. 

The Frac Track addresses the concept of a fraction representing a
specific distance, as opposed to simply a point, on a number
line. It also introduces students to “counting on” incrementally
with fractions, decimals, and percents.

The Frac-o-Wheel is designed to provide multiple representations
of a fraction, to introduce the concept of equivalence, to foster
fraction recognition, and to introduce addition and subtraction
with fractions.

Whack-a-Frac addresses equivalence of fractions, decimals, and
percents. Finally, Fuzzy Fracs deals with concepts of ordering and
relative size of fractions, decimals and percents. Where does one
fraction fall in relation to another fraction? Why is one-half larger
than one-third? 

Each game provides detailed diagnostic help to support students
as they learn. The diagnostic help is designed to be specific to
the problem the student is experiencing. When the program
detects any of a number of possible problems, it provides specific
help to address that problem. Not only does it try to diagnose the
specific problem, but the help that is provided uses specific frac-
tions, decimals and percents from the actual problem. 
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Further, the diagnostic help leads students to their own under-
standing of the fraction concept. Rather than simply providing a
list of rules or algorithms to memorize, the help is written to aid
students in constructing their own rules for understanding frac-
tions. In this way, Fraction Attraction is like no other fraction soft-
ware product. 

Most important is the use of representational models in each
game. The Frac-o-Wheel features a pie chart to represent frac-
tions, and The Frac Track uses number lines disguised in the form
of race tracks. Fuzzy Fracs uses a number line as well, and
Whack-a-Frac features more abstract notations (e.g., written and
numeric fractions, decimals, and percents). The diagnostic help
for each of these games provides alternate representations of frac-
tions in the form of fraction bars, pie charts, and hundreds blocks.

Fraction Attraction is adaptable to students with different needs
and learning styles. Each game has several difficulty levels, allow-
ing the software to continually present new challenges to your
students. Moreover, the off-computer activities provided in this
teacher’s guide can be used as an introduction to, or an exten-
sion of, the learning process.

The NCTM Standards set forth a clear message of what the math-
ematics curriculum should include with regard to fractions, deci-
mals, and percents. Fraction Attraction is our response to that
message: it provides an exciting and motivating environment for
students to construct their own understanding…all while having a
good time!

– Paul Kronmeyer, Product Manager
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To use Fraction Attraction, you’ll need a Macintosh with 25 Mhz,
a 68030 processor or better (68040 processor recommended),
System 7.0 or higher, 8 MB of RAM, and a 640x480 monitor
capable of 256 colors.

Fraction Attraction can be installed in one of three ways. The dif-
ferent methods involve trade-offs between program speed, hard
drive space, and requiring the CD at all times. Please read the
descriptions below to decide which installation option you wish
to use. 

Minimal Installation
Requires: 1.6 MB of hard drive space

Minimal installation copies some of the program resources onto
your hard drive and creates an alias for Fraction Attraction.
When you run Fraction Attraction, you must have the CD in your
CD-ROM drive. This option requires the least hard drive space,
but results in the slowest program performance.  

Standard Installation
Requires: 8 MB of hard drive space

Standard installation copies the Fraction Attraction program onto
your hard drive and leaves the program resources on the CD.
When you run Fraction Attraction, you must have the CD in your
CD-ROM drive.

Full Installation
Requires: 20 MB of hard drive space

Full installation copies all of Fraction Attraction onto your hard
drive. You will not need the CD in the drive, and the program
will run at its optimum speed.

To install the software, place the CD in your CD-ROM drive.
Double-click the Fraction Attraction installer. The Sunburst logo
will appear; click CONTINUE. The Install dialog will appear. Click
INSTALL for the Minimal installation. If you want one of the other
installation options, select Custom Install from the pop-up menu
at the top left corner of the dialog. A new dialog will appear.
Click the option you want (Standard or Full) and click INSTALL.

Get
ting Started

 

SystemSystem
Requirements Requirements 
and Installationand Installation
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Getting Started

Disk Installation
To install from disk you must perform a full installation, which
requires 20 MB of free space on your hard drive.

Place “Fraction Attraction Disk 1” in your floppy drive. Double-
click the Fraction Attraction installer, and follow the on-screen
instructions for the remainder of the installation process.

6 Fraction Attraction
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Main Screen
To run the program from your Macintosh, double-click the
Fraction Attraction icon in the Fraction Attraction folder. To run
the program from Windows 3.1 or Windows ‘95, double-click
the Fraction Attraction icon in the Sunburst Program Group in
the Program Manager.  

The Sunburst logo will appear briefly, followed by the Title Screen.
Click to dismiss the Title Screen or wait a few seconds. The Title
Screen will disappear and the Main Screen will appear. Gilda
Gator, your guide to Fraction Attraction, will walk onto the screen.

Gilda will present a brief audio introduction to the program. You
can end the introduction at any time by clicking the screen. To
repeat the introduction, click Gilda’s button at the bottom
left corner of the screen.

To adjust the sound level, choose Sound from the Options menu.
A dialog will appear. Click and drag the slider to set the volume. 

There are four games students can explore. Race down The Frac
Track, take a spin on The Frac-o-Wheel, knock over Fuzzy Fracs,
or take a crack at Whack-a-Frac! To start playing, click on a game
to enter that feature area or choose a game from the Game menu.

To leave the program, select Quit (Macintosh) or Exit (Windows)
from the File menu.

Running theRunning the
ProgramProgram

Gilda’s Tip:

If your sound is not on

(Macintosh) or you do not have an

installed sound card (Windows), the

introduction will appear in a dialog. If you are

reading the introduction, click the close box

to close the dialog.
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The Frac Track is designed to convey two concepts. First, it intro-
duces the notion that fractions represent a quantifiable distance
on a number line, not simply a position on a number line.
Second, and of equal importance, it helps students develop the
ability to “count on” with fractions.

When you enter The Frac Track, you will see the following screen:

Gilda Gator will walk onto the screen and give a brief overview
of The Frac Track. You can end the overview at any time by
clicking the screen. To repeat the overview, click Gilda’s button
at the bottom left corner of the screen.

In The Frac Track, four horses race along the lanes to reach the
Finish Line. Each horse will have a fraction, decimal, or percent on
its blanket. Horses run in increments of their numbers. The larger
the number, the faster the horse will move along The Frac Track!

There are two types of races. In Place Jockeys, select jockeys
from the Jockeys Area and place them on the horses to make
them finish the race in the order shown in the Grandstand
Windows. In Place Horses, predict the order the horses will finish
by dragging the miniature horses from the Miniature Horses Area
into the Grandstand Windows.

The
Frac Track

OverviewOverview

 

Grandstand
Windows

Race Horses

Score Board

Race Lanes

Gilda’s
Overview

Jockeys Area/ 
Miniature Horses Area

Main
Screen

Gilda’s Tip:

To adjust the sound level,

choose Sound from the Track

Options menu. A dialog will appear. Click

and drag on the slider to set the volume. If

your sound is not on (Macintosh) or you do

not have an installed sound card (Windows),

the overview will appear in a dialog. If you are

reading the overview, click the close box to

close the dialog.
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When a race begins, number lines will appear behind the horses
as they run. A horse’s number is marked on its number line each
time it advances by that increment. For instance, if the horse has
one-third, each unit of the number line will be drawn in thirds as
the horse runs.

When one horse reaches the finish line, the race is over! The
other horses will stop in place, drop horseshoes to show where
they finished, and then slide to the Finish Line. You’ll earn a
score based on how many horses you got right. The horses you
placed correctly will smile and their jockeys will move their
hands.

You can look at the number lines in each lane to see how the
race ended. The number line of the winning horse will be entire-
ly yellow; the number line for each other horse will be filled in
with yellow to the point the horse reached when the race ended,
and then will be white the rest of the way to the Finish Line.

When the race is over, click on the screen. If you got all the hors-
es correct, you will go on to the next race. If you missed any of
the horses, a sign will appear, “Do you want to review the race?”
Click YES to explore why the race ended the way it did, or click
NO to go on to the next race. Each game is five races long.
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The Frac Track Options
You can change The Frac Track game settings to vary the type
and difficulty level of the game. Use the Track Options menu to
change any of the following settings:

❖ Game version (Place Jockeys or Place Horses)

❖ Playing level (1-3)

❖ Race Type (Fraction, Decimal, or Mixture)

❖ Sound level 

The available options are determined by the Teacher Options for
The Frac Track. The default setting is for all options to be avail-
able. You can disable options by choosing Teacher Options from
the Main Screen and then selecting The Frac Track. For more
information on Teacher Options, see page 48.

Choosing a Game
You can choose between two different versions of The Frac
Track:  Place Jockeys or Place Horses. The active version will
have a checkmark next to it in the Track Options menu. The
game you choose will use the current Level and Race Type set-
tings from the Track Options menu.

Place Jockeys

If you choose Place Jockeys from the Track Options menu, your
goal will be to make the horses finish the race in the order shown in
the Grandstand Windows by assigning jockeys to the colored horses.

Playing Playing 
The Frac TrackThe Frac Track

Gilda’s Tip:

If you change any setting

except Sound in the course of a

game, you will end the game. A dialog

will appear to ask if you want to start a new

game. Click RESTART to start a new game or

CANCEL to keep playing.

Grandstand
Windows

Assign fractions
to the horses

Jockeys Area
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There are four jockeys in the Jockeys Area. Each jockey holds a
blanket with a number on it. Compare the numbers to decide
which will make a horse finish in first, second, third, or fourth
place. Then place jockeys so the horses will finish in the order
shown in the Grandstand Windows.

To place a jockey on a horse, click the jockey and then click a
horse. If you want to change a jockey that you’ve placed on a
horse, you must do it before you have placed all 4 jockeys. To
change a jockey, click the jockey and then click the Jockeys
Area. You can then click a new jockey. When all 4 jockeys are in
place, the race will begin! 

Place Horses

If you choose Place Horses from the Track Options menu, your
goal will be to predict the order in which the horses will finish
the race. Each horse on the track already has been assigned a
jockey and a number. Compare the numbers to predict the place
in which each horse will finish.  

In the Miniature Horses Area you will see four small pictures, one
for each horse. Your goal is to place them correctly in the
Grandstand Windows labeled 1st place, 2nd place, 3rd place,
and 4th place. Click a horse and then click in the window where
you think the horse will place. If you want to change a horse,
you must do it before you have placed all 4 horses. To change a

Assign miniature horses
to the Grandstand

Windows

Race Track

Scoreboard

Miniature Horses
Area
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horse, click it and then click the Miniature Horses Area. You can
then click a new horse. When you have filled all the windows in
the Grandstand, the race will begin!  

In both versions, a number line will appear behind each horse as
it runs down the lane. Horses run in increments of the numbers
they are wearing, and a horse’s number is indicated on its num-
ber line each time it travels that distance. For instance, if the
horse is wearing one-third, each unit of the number line will be
drawn in thirds as the horse runs.

When one horse reaches the finish line, the race is over!  Each of
the remaining horses will stop in place, drop a horseshoe to show
where it finished, and then slide to the Finish Line.  

The number line of the winning horse will be entirely yellow:

The number line for each other horse will be filled in with yellow
to the point the horse reached when the race ended, and then
will be white the rest of the way to the Finish Line. The number
lines will also be labeled along the bottom to show the cumula-
tive distance traveled by each horse:

When you answer correctly for a horse’s place, the jockey will
wave and the horse will smile and whinny when the race is over.
If you did not answer correctly, the horse will pass the Finish Line
without animation. You’ll
earn a score based on how
many horses you assigned
correctly: one horse correct
earns one point, two horses
correct earns three points,
and four horses correct
earns eight points.

Gilda’s Tip:

A track is not always only 1

unit. In level 2 the lanes of a track

can be up to 5 units long. In level 3

they can be up to 10 units long.

Cumulative distance shown
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When the race is over, you will be prompted to click the screen.
If you got all the horses right, you will go on to the next race. If
you missed any of the horses, a sign will appear, “Do you want
to review the race?” Click YES to explore why the race ended the
way it did, or click NO to go on to the next race.  

After 5 races, the game is over. Click PLAY AGAIN in the dialog to
play another game with the same settings. After you click PLAY

AGAIN, you can choose new settings from the Track Options
menu. To leave The Frac Track, click the MAIN SCREEN button or
choose a different feature area from the Game menu.

Choosing a Playing Level
When you choose a playing level from the Track Options menu,
it will have a checkmark next to it.  

✓ In Level 1, the horses’ numbers will be fractions, deci-
mals, or percents that are equivalent to unit fractions
(fractions with 1 in the numerator) with 2-12 in the
denominator.  For instance, the horses’ numbers might
be 1/2, 1/5, 1/8, and 1/10. The race track is 1 unit long.  

✓ In Level 2, the horses’ numbers will be fractions, deci-
mals, or percents that are equivalent to proper fractions
with numerators of 1 or numerators that are factors of the
length of the horse’s lane (e.g., if the lane is 4 units long,
the numerator can be 1, 2, or 4). Denominators will be
2-12. For instance, the horses’ numbers might be 1/2,
4/6, 2/6, and 1/10 on a track that is 4 units long. The
race track can be 1-5 units long.

✓ In Level 3, the horses’ numbers will be fractions, deci-
mals, or percents that are equivalent to fractions with
denominators 2-12. Denominators cannot exceed 24.
For instance, the horses’ numbers might be 8/16, 3/18,
6/20, and 2/18. Horses can have improper and mixed
fractions. The race track can be 1-10 units long.

Gilda’s Tip:

There are 5 heats (races) in a

game.
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Choosing a Race Type
The Race Type affects the number format of
horses’ numbers (e.g., fractions, decimals, or
percents). To choose a number format,

select Race Type from the Track Options menu and then choose
Fraction, Decimal, or Mixture from the sub-menu.

The number format produced by Mixture depends on the level
that is selected in the Track Option menu. In Level 1, the num-
bers on the horses can be fractions, decimals, or percents. In
Level 2 or 3, the numbers on the horses can be fractions, deci-
mals, or percents if the race track is one unit long, or fractions
and decimals if the track is two or more units long.

Set the Sound Level
To set the sound level select Sound. A sound volume dialog will
appear. Click and drag the slider to set the volume. The slider
ranges from 0%, no sound, to 100%, which is the loudest.

Gilda’s Tip:

The number format produced by

Mixture depends on the level that

is selected in the Track Options 

menu.
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There are two different kinds of help available for The Frac
Track: general help on the rules and options, and detailed diag-
nostic help to scaffold students into a conceptual understanding
of fractions as representing a quantifiable distance as well as how
to count on with fractions.

General Help
For instructions on how to play The Frac Track, change the game
settings, and get mathematical help, choose Index from the Help
menu. A list of topics will appear. Click a topic to learn more.

Diagnostic Help
Diagnostic help is only available after a race where you did not
get all the horses right. When a race ends, click the screen to
continue. If you missed any horses, a sign will appear: “Do you
want to review the race?”  If you click YES, the Review dialog will
appear.  

Getting Getting 
Frac Track Help Frac Track Help 

Gilda’s Tip:

Diagnostic help provides appro-

priate models and explanations to

help develop students’ understand-

ing of fractions.
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The diagnostic help is designed to identify the error students
made and then provide concrete models and explanations to
help develop their understanding of fractions. The help will be
based on the actual numbers used in the race. Below is an exam-
ple of when students make an error because they believe that a
larger denominator means a larger fraction.

Use the Next and
Previous but-

tons to see all
the information

When you are done
reading the help in the
Review window, click
Cancel to return to

the game and start the
next race! 
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The Frac-o-Wheel provides multiple representations of fractions
as students learn to recognize fractions and build an understand-
ing of fraction equivalents. As they run The Frac-o-Wheel, stu-
dents will also work with equivalence and addition and subtrac-
tion of fractions. The Frac-o-Wheel game screen looks like this:

Gilda Gator will walk onto the screen and give a brief overview
of The Frac-o-Wheel. You can end the overview at any time by
clicking on the screen. To repeat the overview, click Gilda’s but-
ton at the bottom left corner of the screen.

To adjust the sound level, choose Sound from the Wheel
Options menu. A dialog will appear. Click and drag the slider to
set the volume. If your sound is not on (Macintosh) or you do not
have an installed sound card (Windows), the overview will
appear in a dialog. If you are reading the overview, click the
close box to close the dialog.

In The Frac-o-Wheel game, you have an important role – you’re
going to run the ride! There will be between 4 and 12 chairs on
the ride, all with passengers ready to exit. You need to unload
them one chair at a time. Try to unload all the chairs in as few
moves as possible.

The
Frac-O-Wheel

OverviewOverview

The Frac-o-Wheel

Fraction Sign

Ground Level

Flashing Chair

Scoreboard
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When it is time to empty a chair, it will flash. To unload it, figure
out the fraction that will move the chair around the wheel to the
ground. Click the Fraction Sign and then enter the missing part(s)
of the fraction.    

When you have completed the fraction, click the Clockwise or
Counterclockwise button to rotate the wheel the amount of the
fraction you entered.

As a chair moves, lights on the wheel will show its path and the
fractional portion of the wheel it is passing through. If the chair
reaches the ground, the people will exit.  

Click anywhere on the screen to continue and a sign will appear.

Click the sign to investigate how you unloaded the chair, or click
the screen to unload the next chair.  

If the chair does not reach the ground or passes it, enter a new
fraction to try again from the new location. For some mathemati-
cal help, click the Analyze switch.

Every time you unload a chair, it counts as a “hit.” The
Scoreboard shows your hits and tries. When you have unloaded
all the chairs, the game is over and the fireworks will begin! 

Gilda’s Tip:

Use the tab key to move

between the numerator and the

denominator on the Fraction Sign.

Gilda’s Tip:

If the chair does not reach the

ground or passes it, enter a new

fraction to try again from the new

location.
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The Frac-o-Wheel Options
You can change The Frac-o-Wheel game settings to vary the diffi-
culty level of the game. Use the Wheel Options menu to change
any of the following settings:

❖ Playing level (1-4)

❖ Missing Component (Numerator,
Denominator, Both, or Random)

❖ Sound level  

The available options are determined by the Teacher Options for
The Frac-o-Wheel. The default setting is for all options to be
available. You can disable options by choosing Teacher Options
from the Main Screen and then selecting The Frac-o-Wheel. For
more information on Teacher Options, see page 44.

Choosing a Playing Level
When you choose a playing level from the Wheel Options menu,
it will have a checkmark next to it.  

✓ In Level 1, the number of chairs may be 4 or 8. Given
denominators can be 2, 4, or 8 and given numerators
require 2, 4, or 8 in the denominator. For example, with
4 chairs on the ride, the Fraction Sign may be ?/8, or 4/?,
where ? stands for the missing component.

✓ In Level 2, the number of chairs may be 4, 6, 8, 9, or 12.
Given denominators can be 2, 3, 4, 6, 8, 9, and 12 and
given numerators require 2, 3, 4, 6, 8, 9, or 12 in the
denominator. For example, with 9 chairs on the ride, the
Fraction Sign may be ?/9 or 3/?, where ? stands for the
missing component. 

✓ In Level 3, the number of chairs may be 4, 5, 6, 8, 9, 10,
or 12. Given denominators can be any multiple (less than
50) of 2, 3, 4, 5, 6, 8, 9, 10, and 12 and given numera-
tors require any multiple (less than 50) of 2, 3, 4, 5, 6, 8,
9, 10, or 12 in the denominator. For example, with 10
chairs on the ride, the Fraction Sign may be ?/36 or 5/?,
where ? stands for the missing component. 

✓ In Level 4, the number of chairs may be 4 to 12. Given
denominators can be any multiple (less than 100) of 2 to
12 and given numerators require any multiple (less than

Playing The Playing The 
Frac-o-WheelFrac-o-Wheel

Gilda’s Tip:

If you change any setting

except Sound in the course of a

game, you will end the game. A dialog

will appear to ask if you want to start a new

game. Click Restart to start a new game or

Cancel to keep playing.)
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100) of 2 to 12 in the denominator. For example, with 7
chairs on the ride, the Fraction Sign may be ?/77 or 10/?,
where ? stands for the missing component.

Choosing the Missing Component
You can set the part(s) of fractions
that will be missing on the Fraction
Sign by selecting Missing
Component from the Wheel
Options menu, and then selecting Numerator, Denominator,
Both, or Random from the sub-menu.

If you choose Both, you will have to enter the numerator and
denominator for each fraction. If you choose Random, the miss-
ing component(s) will change throughout the game.

All numbers you enter for the missing component(s) must be pos-
itive and between 1 and 99. Denominators must be multiples or
divisors of the number of chairs. For instance, in Level 4 if there
are 12 chairs on the wheel, the denominator can be 1, 2, 3, 4, 6,
12, or any multiple of 12 under 100.

Set the Sound Level
To set the sound level select Sound. A sound volume dialog will
appear. Click and drag the slider to set the volume. The slider
ranges from 0%, no sound, to 100%, which is the loudest.

Gilda’s Tip:

If you enter a possible improper

fraction, the chair will move to its

final location on the wheel, never making

more than one revolution. For example, if you

enter 16/4, the wheel will make one full circle;

if you enter 7/4, the chair will move 3/4 of the

way around the wheel. You will hear an expla-

nation as to why the wheel moved that way.
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There are two different kinds of help available for the Frac-o-
Wheel: general help on the rules and options, and detailed diag-
nostic help to scaffold students into recognizing multiple repre-
sentations of fractions and conceptually understanding fraction
equivalence. 

General Help
For instructions on how to run the Frac-o-Wheel, how to change the
game settings, and get mathematical help, choose Index from the
Help menu. A list of topics will appear. Click a topic to learn more.

Diagnostic Help
The diagnostic help is designed to identify the error students
have made and then provide concrete models and explanations
to help develop their understanding of the fraction concept with
which they are having difficulty. The help is specific to the chair
that is currently being unloaded. Click the Analyze switch and
the following dialog appears: 

❖ Choose “help on my last try” from the window for some
mathematical help with your last answer. For example, if

Getting Getting 
Frac-o-Wheel Frac-o-Wheel 
Help Help 

Gilda’s Tip:

The help is specific to the chair

that is currently being unloaded.
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within a game with a missing numerator you entered a
numerator that did not move the chair to the ground, this
help might appear:

❖ Choose “help from where the chair is now” from the win-
dow for some mathematical help to move the chair to the
ground from its new location. Here’s an example of a hint:

Gilda’s Tip:

If you choose “help from where

the chair is now” before you have

tried to unload the chair, it will

cost 2 tries in the game score!
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❖ Choose “a history of tries on this turn” from the window
to review everything you have done to unload the chair.
This is the same help you will get if you click on the sign
“Click here to investigate your last turn” after you have
unloaded a chair. For example:

For any of the diagnostic help, use the NEXT and PREVIOUS buttons
to see all the information. Click CANCEL when you are done.

End of Game
When all the chairs have been emptied, the game is
finished and you still have an opportunity to analyze
your last turn before the fireworks go off to celebrate
your effort. The Scoreboard will show hits, tries, and a
ratio of hits to tries. 

A dialog will appear to ask if you want to play again or
return to the Main Screen. Click PLAY AGAIN to start a
new game.



The Frac-o-Wheel

After you click PLAY AGAIN, you can choose a different level or
change the Missing Component in the Wheel Options menu. To
leave The Frac-o-Wheel, click the MAIN SCREEN button or choose
a different feature area from the Game menu.
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Wow!  That

was a fun ride!

Yeah!  Let’s do

it again!

I feel dizzy!
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Students will practice ordering fractions, counting with fractions,
and recognizing relative size as they try to knock down Fuzzy
Fracs in size order. The Fuzzy Fracs game screen looks like this:

Fuzzy Fracs are arranged in three rows on the Game Board. Each
Fuzzy Frac has a number on it (fraction, decimal, or percent). Your
goal is to knock over all the Fuzzy Fracs in size order. You can
knock them down from smallest to largest or largest to smallest.

At the start of a game, a ball rolls out onto the Countertop. Pick
up a ball by clicking it and then click a Fuzzy Frac to throw the
ball. Each time you knock over a Fuzzy Frac, its number is
marked with a solid black triangle on the Number Line. To con-
tinue, click the BALL FEEDER button to get a new ball and then try
to hit the Fuzzy Frac that’s next in order.  

Each correct Fuzzy Frac counts as a “hit.”  When you’ve knocked
down all possible Fuzzy Fracs, the game is over. A scoreboard
will slide out from the Results Area to show your hits and tries.
You can then click any Fuzzy Frac you missed and click ANALYZE

for more mathematical help.

Fuzz
y Fracs

OverviewOverview

Fuzzy Frac

Analyze Button

Ball Feeder

Countertop

Help Number Line Main Screen Results
Area

Gilda’s Tip: 

If you skip any Fuzzy Fracs,  hol-

low triangles will mark their places

on the Number Line and the Fuzzy

Fracs will turn gray. You can’t knock gray

Fuzzy Fracs down. To find out why a Fuzzy

Frac turned gray, click on it and then click

the Analyze button.
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Fuzzy Fracs Options
You can change the Fuzzy Fracs game settings to create different
learning experiences. Use the Fuzzy Options menu to change
any of the following settings:

❖ Game version (Smallest to Largest or Largest
to Smallest)

❖ Playing level (1-5)

❖ Fuzzy Type (Fraction, Decimal, or Mixture)

❖ Sound level  

The available options are determined by the Teacher Options for
Fuzzy Fracs. The default setting is for all options to be available.
You can disable options by choosing Teacher Options from the
Main Screen and then selecting Fuzzy Fracs. For more informa-
tion on Teacher Options, see page 45.    

Choosing a Game
You can choose between two different game versions: Smallest to
Largest or Largest to Smallest. The active version will have a check-
mark next to it in the Fuzzy Options menu. The version you choose
will use the current Level and Fuzzy Type settings from the Fuzzy
Options menu.

To start either version, click to pick up a ball. If you are playing
Smallest to Largest, try to hit the smallest Fuzzy Frac first, and then
continue to hit Fuzzy Fracs in increasing size order. If you are
playing Largest to Smallest, try to hit the largest Fuzzy Frac first,
and then continue to hit Fuzzy Fracs in decreasing size order. 

If you skip a Fuzzy Frac, it will turn gray and you won’t be able
to knock it down.

Gilda’s Tip: 

If you change any setting

except Sound in the course of a

game, you will end the game. A dialog

will appear to ask if you want to start a new

game. Click Restart to start a new game or

Cancel to keep playing.

Playing Playing 
Fuzzy FracsFuzzy Fracs

Gray Fuzzy
Frac
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When you’ve knocked over all possible
Fuzzy Fracs, the game is over and the score-
board will appear from the Results Area to
show you your hits, tries, and total points.
Scoring is as follows:

● one Fuzzy Frac hit correctly = 1 point
● two Fuzzy Fracs hit correctly = 2 points
● three Fuzzy Fracs hit correctly = 4 points
● four Fuzzy Fracs hit correctly = 8 points
● n Fuzzy Fracs hit correctly = 2n-1 points

If you hit 90-100% of the Fuzzy Fracs, they will reappear and
dance at the end of the game because you did such a great job!
If you hit 80-90% of the Fuzzy Fracs, they will make funny faces
at the end of the game as a reward! If you miss any Fuzzy Fracs,
the Fuzzy Fracs will reappear at the end of the game and swing
up and down in appreciation of your effort.

At the end of a game, you can start a new game of the same ver-
sion by clicking the Countertop or selecting New Game from the
File menu. You can also choose a different version or change
other settings in the Fuzzy Options menu before playing again.
To leave Fuzzy Fracs, click the MAIN SCREEN button or choose a
different feature area from the Game menu.

Choosing a Playing Level
When you choose a playing level from the Fuzzy Options menu,
it will have a checkmark next to it.  

✓ In Level 1, there are 6 Fuzzy Fracs. The numbers on the
Fuzzy Fracs are fractions or decimals equal to unit frac-
tions (fractions with 1 in the numerator) with denomina-
tors of 2-12. For instance, Fuzzy Fracs can be labeled
1/2, .3, etc. The Number Line goes from 0 to 1.  

✓ In Level 2, there are 9 Fuzzy Fracs. The numbers on the
Fuzzy Fracs are fractions or decimals equal to proper
fractions with 2, 4, 8, or 16 in the denominator or unit
fractions with denominators of 2-12. For instance, Fuzzy
Fracs can be labeled 9/16, .188, etc. The Number Line
goes from 0 to 1. 

Gilda’s Tip:

At the end of a game, you can

start a new game of the same

version by clicking the Countertop or

selecting New Game from the File menu.
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✓ In Level 3, there are 12 Fuzzy Fracs. The numbers on the
Fuzzy Fracs are fractions or decimals equal to proper
fractions with 2, 3, 4, 6, 8, 9, 12, 15 or 16 in the denom-
inator. For instance, Fuzzy Fracs can be labeled 12/15,
.83, etc. The Number Line goes from 0 to 1.

✓ In Level 4, there are 15 Fuzzy Fracs. The numbers on the
Fuzzy Fracs are fractions, decimals, or percents equal to
proper or improper fractions less than 2. Fraction denomi-
nators can be 2-16 (except 11 and 13) or multiples of those
numbers; fractions can also have denominators 16-99
(excluding primes in the numerator) that are reducible to
sixteenths or larger. For instance, Fuzzy Fracs can be
labeled 99/90, 1.5, etc. The Number Line goes from 0 to 2.

✓ In Level 5, there are 18 Fuzzy Fracs. The numbers on the
Fuzzy Fracs are fractions, decimals, or percents equal to
proper or improper fractions less than 5. Fractions can
also be displayed in textual format. Fraction denomina-
tors can be 2 to 16 (except 11 and 13) or multiples of
those numbers; fractions can also have denominators 16-
99 (excluding primes in the numerator) that are reducible
to sixteenths or larger. For instance, Fuzzy Fracs can be
labeled 75/18, 28.6%, etc. The Number Line stretches
from 0 to the whole number after the largest fraction
used in the game.  

Choosing a Fuzzy Type
To choose the number format of the
Fuzzy Fracs, select Fuzzy Type from the
Fuzzy Options menu and choose a for-
mat from the sub-menu: Fractions, Decimals, or Mixture.

If you choose Mixture, the kinds of numbers depend on the
Level setting. Levels 1, 2, and 3 will have some Fuzzy Fracs with
fractions and some with decimals. Level 4 will have some Fuzzy
Fracs with fractions, some with decimals, and some with per-
cents. Level 5 will have some Fuzzy Fracs with fractions, some
with decimals, some with percents, and some with written frac-
tions (like “one-third”) as shown below: 

Gilda’s Tip:

Improper fractions and decimal

equivalents are introduced in lev-

els 4 and 5.

Gilda’s Tip:

In level 5, fractions can be rep-

resented in textual form.
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Set the Sound Level
To set the sound level select Sound. A sound volume dialog will
appear. Click and drag the slider to set the volume. The slider
ranges from 0%, no sound, to 100%, which is the loudest.
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There are two different kinds of help available for Fuzzy Fracs:
general help providing the rules and options, and detailed diag-
nostic help to scaffold students into a conceptual understanding
of ordering fractions and recognizing relative size of fractions.

General Help
For instructions on how to play Fuzzy Fracs, how to change the
game settings, and how to get mathematical help, choose Index
from the Help menu. A list of topics will appear. Click a topic to
learn more.

Diagnostic Help
At any point during a game, a student can investigate the gray
Fuzzy Fracs and get help with ordering. By clicking a gray Fuzzy
Frac during a game, a red box will appear around it and a flash-
ing red marker will show its location on the Number Line.
Students can also click a hollow triangle on the number line to
make it turn red and select its gray Fuzzy Frac. To explore why
that Fuzzy Frac should have been next in order, click Analyze. A
dialog will appear with explanations correlated to the type of
error the student made. It provides students with a visual model
for understanding the concept of relative size. 

Getting Getting 
Fuzzy Fracs Fuzzy Fracs 
HelpHelp

Gilda’s Tip:

You can also click a hollow tri-

angle on the number line to make

it turn red and select its gray Fuzzy

Frac.
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In most cases, the diagnostic help will compare the missed Fuzzy
Frac to the next correctly hit Fuzzy Frac. The help will be based
on the actual numbers used in the game. For example, if a stu-
dent hit 1/5 before 1/8 in the Smallest to Largest game, they
would see:

Use the NEXT and PREVIOUS buttons to see all the information,
and click CANCEL when you are done.

Gilda’s Tip: 

You are not restricted to ana-

lyzing fractions during a game. At

the end of the game, you can also

click ANALYZE to compare Fuzzy Fracs you

missed with Fuzzy Fracs you hit.
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Whack-a-Frac is designed to help students build an understand-
ing of equivalence of fractions, decimals, and percents. The
Whack-a-Frac game screen looks like this:

At the start of a game, the mouse cursor is a coin. Click on the
Coin Slot near the bottom right of the Game Board to begin. The
cursor will change to a mallet, a Target number will appear on
the left side of the Challenge Board, and three Frac-Moles will
pop out of holes on the Game Board. 

Each Frac-Mole bears a number and holds two signs, Yes and
No. If a Frac-Mole’s number is equal to the Target, click Yes to
whack it! If it is not equal, click the No sign. Each correct answer
counts as a “hit.” You can see how many hits you have by look-
ing at the Hits counter.

If you whack a Frac-Mole incorrectly, you can get immediate
mathematical help by clicking ANALYZE. At the end of the game, a
scoreboard will slide out from the Results Area to show you how
you did.  

Whack-A-Frac

OverviewOverview

Gilda’s Tip: 

Keep an eye on the Target

because it changes during the

game!  If the sound is on, you’ll

hear a bell when the Target changes. 

Help

Analyze Goal Coin
Slot

Main
Screen

Results
Area

Challenge Board

Hits
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Whack-a-Frac Options
While the basic rules of Whack-a-Frac are always the same (click
the Yes sign if the Frac-Mole is equal to the Target, or the No
sign if it is not), you can change game settings to create a variety
of different experiences. Use the Whack Options menu to
change the following settings:

❖ Game version (Untimed Game, Timed
Game, or Timed Frac-Moles)

❖ Playing level (1-4)

❖ Goal number

❖ Target number format (Fraction, Decimal,
Percent, Text, or Random)

❖ Sound level

The available options are determined by the Teacher Options for
Whack-a-Frac. The default setting is for all options to be avail-
able. You can disable options by choosing Teacher Options from
the Main Screen and then selecting Whack-a-Frac. For more
information on Teacher Options, see page 46.

Choosing a Game
You can choose from three different game versions: Untimed
Game, Timed Game, or Timed Frac-Moles. The active version
will have a checkmark next to it in the Whack Options menu.
The version you choose will use the current Level and Target set-
tings from the Whack Options menu.

To start any version, click on the Coin Slot. A Target will appear
in the Challenge Area and Frac-Moles will pop out of holes on
the Game Board. There can be a maximum of three Frac-Moles
on the Game Board at any time. As you play, remember to
watch for the changing Target! If your sound is on, a warning bell
will ring when the Target is changing.

If you get 90-100% right, the Frac-Moles will jump
up and down out of their holes in recognition of
your hard work! 

The scoreboard will pop out of the Results Area
to show you your hits, tries, ratio of hits to tries,
and time (when appropriate). You can then start

Gilda’s Tip: 

If you change any setting

except Sound in the course of a

game, you will end the game. A dialog

will appear to ask if you want to start a new

game. Click Restart to start a new game or

Cancel to keep playing.

PlayingPlaying
Whack-a-FracWhack-a-Frac
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a new game of the same version by clicking the Coin Slot or by
selecting New Game from the File menu. You can also choose a
different version of Whack-a-Frac or change other settings in the
Whack Options menu before playing again. To leave Whack-a-
Frac, click the MAIN SCREEN button or choose a different area from
the Game menu.

Untimed Game

In the Untimed Game, there are no time constraints so you can
take as long as you like to explore and experiment. Each Frac-
Mole will stay out of its hole until you click its Yes or No sign.
Each correct answer counts as a “hit.”  

You must earn enough hits to reach the Goal in order to end the
game. 

You can pick a Goal for the game by choosing Set Goal from the
Whack Options menu. A dialog will appear to let you enter a
Goal. The default range is 1 to 999, but the Goal range can be
limited with the Teacher Options (see page 46).

Gilda’s Tip:

If you plan for students to use

the diagnostic help extensively,

encourage them to play the Untimed 

Game.

Gilda’s Tip:

Use Teacher Options to limit

the goal range available to the

student.
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Enter a Goal within the range specified and click OK. If you start a
game without setting a Goal, the program will choose a default
Goal. If the range is under 10, the Goal will be the highest number
in the range; if the range is over 10, the Goal will default to the the
lowest number in the range.

Timed Game

If you choose Timed Game, you’ll see
a sub-menu with a choice of game
lengths: 30 seconds, 1 minute, 2 min-
utes, or 4 minutes. Select a time.

When the game starts, a Timer will appear to the right of the
Target on the Challenge Board. The Timer will count up from 0
seconds. Frac-Moles will stay on the screen until you click their
Yes or No signs. There is no Goal number – just try to see how
many hits you can get before the time is up!  

Timed Frac-Moles

If you choose Timed Frac-Moles, you will need to work fast to
outsmart the Frac-Moles! Frac-Moles will stay on the screen for
only a few seconds. Each Frac-Mole that disappears before you
can whack it counts as a “try” in your final score. Each correct

Gilda’s Tip:

If you don’t set a Goal, then

Fraction Attraction will select a

default goal for you.

Gilda’s Tip:

In Timed Games, whack as

many Frac-Moles as you can in a

limited amount of time. Note the Time

Window.
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whack counts as a “hit.”  The more hits you get, the faster the
Frac-Moles will move!  

In order to end the game, you must earn
enough hits to reach the Goal. At the end of
the game, the Scoreboard will slide out from
the Results Area to show your hits and tries,
and how long it took to reach the Goal.

You can pick a Goal for the game by choosing Set Goal from the
Whack Options menu. A dialog will appear to let you enter a
Goal. The default range is 1 to 999, but the Goal range can be lim-
ited with the Teacher Options (see page 46). Enter a Goal within
the range specified and click OK. If you start a game without set-
ting a Goal, the program will choose the Goal. If the range is under
10, the Goal will be the highest number in the range; if the range
is over 10, the Goal will be the lowest number in the range.

Choosing a Playing Level
When you choose a playing level from the Whack Options
menu, it will have a checkmark next to it.  

✓ In Level 1, Targets will be equivalents (fractions, deci-
mals, or percents) to reduced fractions with denominators
from 2 to 4. Frac-Moles will always wear fractions; either
equivalents or inequivalents of the Targets with denomi-
nators up to 24 or prime denominators less than 11.  

✓ In Level 2, Targets will be equivalents of fractions with
denominators from 2 to 5 and 10. Frac-Moles will always
wear fractions; either equivalents of the Targets with
denominators up to 50, or inequivalents of the Targets
with denominators up to 50 or prime denominators less
than 11.

✓ In Level 3, Targets will be equivalents of fractions with
denominators from 2 to 16, excluding 7, 11, and 13.
Frac-Moles can wear fractions, decimals, percents, or
written fractions; either equivalents of the Targets with
denominators up to 50, or inequivalents of the Targets
with denominators up to 50 or prime denominators less
than 11.  
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✓ In Level 4, Targets will be equivalents of fractions with
denominators from 2 to 16, excluding 13. Frac-Moles can
bear fractions, decimals, percents or written fractions;
with denominators up to 99 (excluding primes), which
are reducible to sixteenths or larger up to 99 or prime
denominators less than 11.  

Choosing Target Numbers
To choose the number format of the
Target, select Target from the Whack
Options menu and choose a format from
the sub-menu: Fractions, Decimals,
Percents, Text (fractions in textual format), or Random (a mix of
Fractions, Decimals, Percents, and Text). The current selection
will have a checkmark.

Set the Sound Level
To set the sound level select Sound. A sound volume dialog will
appear. Click and drag the slider to set the volume. The slider
ranges from 0%, no sound, to 100%, which is the loudest.
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There are two different kinds of help provided for Whack-a-Frac:
general help on the rules and options, and detailed diagnostic
help to scaffold students into a conceptual understanding of
equivalence.

General Help
For instructions on how to play Whack-a-Frac, change the game
settings, and get mathematical help, choose Index from the Help
menu. A list of topics will appear. Click a topic to learn more.

Diagnostic Help
At any point during a game, you can click ANALYZE to investigate
your last answer. When you click ANALYZE, you “freeze” the
game. You won’t be able to see numbers on any Frac-Moles, and
the time you spend reading the Analyze dialog won’t count for
the overall game time.

The Analyze window will provide explanations based on the
error that was made by the student, as well as provide concrete
models to help compare the incorrectly hit Frac-Mole to the
Target. For example, if students do not recognize fractions as

Getting Getting 
Whack-a-Frac Whack-a-Frac 
Help Help 
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equivalent when one fraction is not reduced to its lowest terms,
they will see the following:

When you are done reading
the help in the Analyze
window, click Cancel to
return to the game and

continue whacking! 

Use the Next and
Previous buttons to

see all the information.
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Teacher Options are available only from the Main Screen. Press
Command-T (

 

z-T, Macintosh) or Control-T (Windows) to bring
up the Teacher Options dialog.

Click the radio button for the game you want to modify and then
click CUSTOMIZE. A dialog will appear for that game. Click to
select or deselect boxes for specific options. The default settings
for every game are for all options to be available to students and
for sound to be on.

In each area, to save your changes as the new default settings,
click the box by Save settings as default. If you do not select this
option, the program will keep these settings for the current ses-
sion only. It will revert to the original defaults when you exit
Fraction Attraction and run the software again.

When you have finished making changes, click OK to exit the
dialog and save your settings, or click CANCEL to exit without sav-
ing changes.

Each time you finish modifying a game, you will return to the
main Teacher Options dialog and can choose to customize
another game or to return to the Main Screen.

When you have finished setting Teacher Options, click DONE to
return to the Main Screen.

Reference

SettingSetting
Teacher OptionsTeacher Options

Gilda’s Tip:

In each area, to save your

changes as the new default set-

tings, click the box by Save settings as

default.
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The Frac-o-Wheel Teacher Options
In The Frac-o-Wheel students learn to recognize multiple repre-
sentations of fractions and develop an understanding of fraction
equivalence. You can use the Teacher Options to ensure that stu-
dents work with the type of fractions and missing fraction com-
ponent best suited to  their level of understanding.  

If you choose The Frac-o-Wheel from the Teacher Options dia-
log, a dialog specific to The Frac-o-Wheel will appear. The
options you set will affect what is available in the Wheel Options
menu for the game.

Set the problem level by choosing one or more levels. The
default setting is for all levels to be available to students. You
must choose at least one level; if no level is selected, you will not
be able to save your changes.

Set the missing component by choosing Numerator,
Denominator, Numerator and Denominator, or Random
Generation. The default setting is for all missing component
options to be available to students. At least one missing compo-
nent must be selected in order for you to save your changes.

Sound is controlled by the Turn sound on option, which is select-
ed by default. Deselect this option to turn off sound for The Frac-
o-Wheel portion of Fraction Attraction.

Gilda’s Tip:

If you don’t want to save your

settings as the new default set-

tings for the current session of

Fraction Attraction, click CANCEL to exit with-

out saving changes.
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Fuzzy Fracs Teacher Options
In Fuzzy Fracs, students order fractions, count with fractions, and
recognize relative size of fractions. You can use the Teacher
Options to ensure that students work with the type of fractions,
number format, and game version that will present an appropri-
ate challenge given their level of understanding.  

If you choose Fuzzy Fracs from the Teacher Options dialog, a dia-
log specific to Fuzzy Fracs will appear. The options you set will
affect what is available in the Fuzzy Options menu for the game.

Set the problem level by choosing one or more levels. The
default setting is for all levels to be available to students. You
must choose at least one level; if no level is selected, you will not
be able to save your changes.

There are two versions: Smallest to Largest and Largest to
Smallest. Set the version (Mode) by choosing Smallest to Largest
or Largest to Smallest. The default setting is for both versions to
be available to students. At least one version must be selected for
you to save your changes.

Set the Fuzzy Type by choosing one or more formats for the
Fuzzy Fracs (Fraction, Decimal, and Mixed). The default setting is
for all formats to be available to the students. At least one format
must be selected for you to save your changes.

Sound is controlled by the Turn sound on option, which is selected
by default. Deselect this option to turn off sound for Fuzzy Fracs.

Gilda’s Tip:

Don’t forget to save your

changes as the new default set-

tings by clicking the box marked “Save

settings as default.” Otherwise, your set-

tings will be for the current session only.
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Whack-a-Frac Teacher Options
In Whack-a-Frac, students learn to recognize equivalent num-
bers. You can use the Teacher Options to ensure that students
work with the type of fractions, number format, and game ver-
sion that will help them enhance and move beyond their current
level of understanding.  

If you choose Whack-a-Frac from the Teacher Options dialog,  a
dialog will appear. The options you set will affect what is avail-
able in the Whack Options menu for the game.

Set the problem level by choosing one or more levels. The
default setting is for all levels to be available to students. You
must choose at least one level; if no level is selected, you will not
be able to save your changes.

Set the game version according to your teaching preference by
choosing Untimed Game, Timed Game, or Timed Frac-Moles.
The default setting is for all game modes to be available. At least
one version must be selected in order for you to save your
changes.

Set the format for the Target that will be available to the students
by choosing one or more formats (Fraction, Decimal, Percent,
Text, and Random). The default setting is for all formats to be
available to students. At least one format must be selected in
order for you to save your changes.
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The default range for the Goal is from 1 to 999. To limit the Goal
students can set for a game, enter numbers in the text boxes. To
create a fixed Goal, enter the same number in both text boxes. If
you set a fixed Goal, the Set Goal option will be grayed out in
the Whack Options menu.

Sound is controlled by the Turn sound on option, which is select-
ed by default. Deselect this option to turn off sound for Whack-
a-Frac.

A Final Reminder
To save your changes as the new default settings for any game,
click the box by Save settings as default. If you do not select this
option, the program will keep these settings for the current ses-
sion only. It will revert to the original defaults when you exit
Fraction Attraction and run the software again.

When you have finished making changes, click OK to exit the
dialog and save your settings, or click CANCEL to exit without sav-
ing changes.

Gilda’s Tip:

If you don’t set a Goal, then

Fraction Attraction will select a

default goal for you.
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The Frac Track Teacher Options
The Frac Track helps students to recognize fractions as quantifi-
able distances on a number line and to develop the ability to
“count on” with fractions. You can use the Teacher Options to
ensure that students work with the number format, type of frac-
tions, and game version most appropriate for their level of under-
standing.  

If you choose The Frac Track from the Teacher Options dialog, a
dialog specific to The Frac Track will appear. The options you set
will affect what is available in the Track Options menu for the game. 

Set the problem level by choosing one or more levels. The
default setting is for all levels to be available. You must choose at
least one level; if no level is selected, you will not be able to save
your changes.

There are two versions of The Frac Track. Set the game version
(Mode) by choosing Place Jockeys, Place Horses, or both. The
default setting is for both game versions to be available to stu-
dents. At least one version must be selected in order to save your
changes.

Set the Race Type (Format) by choosing one or more formats for
the horses’ numbers (Fraction, Decimal, and Mixed). The default
setting is for all formats to be available. At least one format must
be selected in order to save your changes.

Sound is controlled by the Turn sound on option, which is selected
by default. Deselect this option to turn off sound for The Frac Track.

Gilda’s Tip:

At least one option in each

area of The Frac Track Teacher

Options must be selected in order

to save changes.
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File Menu
The File menu has two commands:

● New Game – begins a new game with
the current settings in any of the four
games; this option is not active at the
Main Screen.

● Quit (Macintosh) or Exit (Windows) –
brings up a dialog so you can exit the
program.

Options Menu
The Options menu, available only at the Main Screen, has one
command:

● Sound – brings up a dialog to let you
control the volume. Drag the slider to
set the volume from 0% (no sound) to
100% (the loudest).

Track Options Menu
The Track Options menu, available only in The Frac Track, has
the following commands:

● Place Jockeys – sets the game mode to
Place Jockeys.

● Place Horses – sets the game mode to
Place Horses.

● Level 1 – sets the difficulty level to Level
1. Horses’ numbers will be fractions,
decimals, or percents equivalent to unit
fractions (fractions with 1 in the numer-
ator) with 2-12 (except 7) in the denom-
inator. The race track is 1 unit long.

FractionFraction
AttractionAttraction
MenusMenus
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● Level 2 – sets the difficulty level to Level 2. Horses’
numbers will be fractions, decimals, or percents
equivalent to proper fractions with numerators of 1 or
factors of the length of the lane and denominators of
2-12, except 7. The race track can be 1 - 5 units long.

● Level 3 – sets the difficulty level to Level 3. Horses’
numbers will be fractions, decimals, or percents
equivalent to fractions with denominators 2- 12,
except 7. Denominators cannot exceed 24. Horses
can have improper and mixed fractions. The race
track can be 1 - 10 units long.

● Race Type – Lets you choose a format for the horses’
numbers from the sub-menu: Fraction, Decimal, or
Mixed.

● Sound – brings up a dialog to let you control the
volume.

Wheel Options Menu
The Wheel Options menu, available only in The Frac-o-Wheel,
has the following commands:

● Level 1 – sets the difficulty level to
Level 1. The number of chairs may
be 4 or 8. Given denominators can
be 2, 4, or 8. 

● Level 2 – sets the difficulty level to
Level 2. The number of chairs may
be 4, 6, 8, 9, or 12. Given denomi-
nators can be 2, 3, 4, 6, 8, 9, and
12.

● Level 3 – sets the difficulty level to Level 3. The num-
ber of chairs may be 4, 5, 6, 8, 9, 10, or 12. Given
denominators can be any multiple (less than 50) of 2,
3, 4, 5, 6, 8, 9, 10, and 12.     

● Level 4 – sets the difficulty level to Level 4. The num-
ber of chairs may be 4-12. Given denominators can
be any multiple (less than 100) of 2-12.   
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● Missing Component – Lets you choose what part(s)
of the Fraction sign you will have to complete. Use
the sub-menu to choose Numerator, Denominator,
Both, or Random.

● Sound – brings up a dialog to let you control the
volume.

Fuzzy Options Menu
The Fuzzy Options menu, available only in Fuzzy Fracs, has the
following commands:

● Smallest to Largest (Mode) – sets the
game version to Smallest to Largest.

● Largest to Smallest (Mode) – sets the
game version to Largest to Smallest.

● Level 1 – sets the difficulty level to Level 1.
There are 6 Fuzzy Fracs. The numbers on
the Fuzzy Fracs are fractions, decimals, or
percents equal to unit fractions (fractions
with 1 in the numerator) with denominators
of 2-12. The Number Line goes from 0 to 1.

● Level 2 – sets the difficulty level to Level 2. There are
9 Fuzzy Fracs. The numbers on the Fuzzy Fracs are
fractions, decimals, or percents equal to proper frac-
tions with 2, 4, 8, or 16 in the denominator. The
Number Line goes from 0 to 1. 

● Level 3 – sets the difficulty level to Level 3. There are
12 Fuzzy Fracs. The numbers on the Fuzzy Fracs are
fractions, decimals, or percents equal to proper frac-
tions with 2, 3, 4, 6, 8, 9, 12, 15 or 16 in the denom-
inator. The Number Line goes from 0 to 1.

● Level 4 – sets the difficulty level to Level 4. There are 15
Fuzzy Fracs. The numbers on the Fuzzy Fracs are frac-
tions, decimals, or percents equal to proper or improper
fractions less than 2. Fraction denominators can be 2-16
(except 11 and 13) or multiples of those numbers; frac-
tions can also have denominators 16-99 (excluding
primes in the numerator) that are reducible to sixteenths
or larger. The Number Line goes from 0 to 2.
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● Level 5 – sets the difficulty level to Level 5. There are
18 Fuzzy Fracs. The numbers on the Fuzzy Fracs are
fractions, decimals, or percents equal to proper or
improper fractions less than 5. Fractions equal to or
smaller than twelfths can also be displayed in textual
format. Fraction denominators can be 2-16 (except
11 and 13) or multiples of those numbers; fractions
can also have denominators 16-99 (excluding primes
in the numerator) that are reducible to sixteenths or
larger. The Number Line goes from 0 to the whole
number after the largest fraction used in the game.  

● Fuzzy Type – Lets you choose the number format of
the Fuzzy Fracs. Use the sub-menu to choose
Fraction, Decimal, or Mixture.

● Sound – brings up a dialog to let you control the
volume.

Whack Options Menu
The Whack Options menu, available only in Whack-a-Frac, has
the following commands:

● Untimed Game – sets the game ver-
sion to Untimed Game.

● Timed Game – sets the game version
to Timed Game. If you choose Timed
Game, choose a game length from the
sub-menu: 30 seconds, 1 minute, 2
minute, or 4 minutes.

● Timed Frac-Moles – sets the game ver-
sion to Timed Frac-Moles.

● Level 1 – sets the difficulty level to Level
1. Targets will be equivalents (fractions,
decimals, or percents) of reduced frac-
tions with denominators from 2 to 4.
Frac-Moles will always wear fractions;
either equivalents of the Targets with
denominators up to 24, or inequivalents
of the Targets with denominators up to
24 or prime denominators less than 11.
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● Level 2 – sets the difficulty level to Level 2. Targets
will be equivalents of fractions with denominators
from 2 to 5 and 10. Frac-Moles will always wear frac-
tions; either equivalents of the Targets with denomi-
nators up to 50, or inequivalents of the Targets with
denominators up to 50 or prime denominators less
than 11.

● Level 3 – sets the difficulty level to Level 3. Targets
will be equivalents of fractions with denominators
from 2 to 16, excluding 7, 11, and 13. Frac-Moles
can wear fractions, decimals, percents or written frac-
tions; either equivalents of the Targets with denomi-
nators up to 75, or inequivalents of the Targets with
denominators up to 75 or prime denominators less
than 11.  

● Level 4 – sets the difficulty level to Level 4. Targets
will be equivalents of fractions with denominators
from 2 to 16, excluding 13. Frac-Moles can bear frac-
tions, decimals, percents or written fractions; either
equivalents of the Target Numbers with denominators
up to 99, or inequivalents of the Target Numbers
with denominators up to 99 or prime denominators
less than 11.  

● Set Goal – brings up a dialog to allow you to enter a
new Goal number.

● Target – Lets you choose the number format of the
Target. Use the sub-menu to choose Fractions,
Decimals, Percents, Text, or Random.

● Sound – brings up a dialog to let you control the
volume.



Reference Section

54 Fraction Attraction

Game Menu
The Game menu lets you navigate through the program. The
game screen you are currently in will be grayed out. The Game
menu contains the following commands:

● Main Screen – takes you to the Main
Screen.

● The Frac Track – takes you to The Frac
Track.

● The Frac-o-Wheel – takes you to The
Frac-o-Wheel.

● Fuzzy Fracs – takes you to Fuzzy Fracs.

● Whack-a-Frac – takes you to Whack-a-
Frac.

If you select a different game or area from the Main Screen, a dia-
log will appear asking you to confirm that you want to leave. Click
LEAVE to exit that game screen, or DON’T LEAVE to stay in that game.

Help Menu
The Help menu contains two commands:

● Index – takes you to the Help screen,
which offers help on operating Fraction
Attraction.

● Using Help – explains how to use the
on-line Help.


